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INVESTIGATION OF THE EFFECTSCALCINATION TEMPERATURE ON
THEPHYSIOCHEMICAL PROPERTIES OF HETEROGENOUS CATALYSTS
PRODUCED FROM EGGSHELL AND RICE HUSK

ABSRACT

The production, security, sustainability, and affordability of energy are crucial factors in
various industries and physical and chemical processes. To address environmental concerns
and promote energy production, solid waste materials can serve as catalysts. This research
specifically investigates the influence of different calcination temperatures on the properties
of two solid wastes, namely Eggshell and Rice husk, as heterogeneous catalysts in Biodiesel
production.The raw materials, Eggshell and Rice husk, were locally sourced from Bosso,
Minna Niger State. Eggshell was subjected to calcination temperatures of 600 °C, 650 °C, and
700 °C in a muffle furnace, labeled as KA, KB, and KC, respectively. Rice husk, on the other
hand, underwent calcination temperatures of 600 °C, 700 °C, and 800 °C in a muffle furnace,
labeled as KD, KE, and KF, respectively.The results of the study revealed notable changes in
various properties such as color, mass, chemical transformation, crystallinity, and functional
groups as the calcination temperatures increased for both raw materials. X-ray diffractometer
(XRD) analysis was used to characterize the calcined Eggshells and Rice husks. It was
observed that increasing the calcination temperature led to enhanced crystallinity and
chemical transformation in the eggshells. Conversely, the Rice husks exhibited decreased
crystallinity but increased chemical transformation with higher calcination temperatures. The
presence of a small amount of K;O in the calcined Rice husk was attributed to leaching with
HCI after roasting and quenching before calcination. Furthermore, the Fourier Transform
Infrared Spectroscopy (FT-IR) analysis indicated the formation of desirable functional peaks
with increasing calcination temperatures in both materials. Additionally, the presence of CO3
2 was observed in KA and KB due to the incomplete decomposition of CaCOs. Notably, the
highest formation of CaO occurred at 700°C for Eggshell, while the Rice husk calcined at
800°C exhibited the highest formation of silicon (IV) oxide and lower impurity content
(lignin, cellulose, and hemicellulose). Overall, this research provides valuable insights into
the effects of calcination temperatures on the properties of Eggshell and Rice husk as
catalysts for Biodiesel production. The findings highlight the potential of utilizing solid waste
materials as catalysts for energy production while also considering the optimization of
calcination temperatures to enhance their performance.

Keywords: Characterization, physicochemical, chemical transformation, calcination
temperature.

INTRODUCTION

Energy is widely recognized as a fundamental factor in economic growth and essential for
various aspects of human life, including sustainable industrial development, transportation,
and electricity generation. However, the depletion of fossil fuel reserves, coupled with

environmental concerns and high costs associated with fossil fuel combustion, has



highlighted the need for alternative energy sources. One promising alternative is biofuels,
such as biodiesel (Olutoye et al., 2016). To address potential fuel crises, high costs, and
environmental challenges linked to fossil fuels, the search for environmentally friendly
energy substitutes is essential. One potential source of such substitutes is biofuels, with
biodiesel being a particularly promising option (Olutoye et al., 2016). Among the abundant
solid waste materials generated daily, eggshells have emerged as a potential resource with
economic value. Instead of incurring costly disposal methods, eggshells can be economically
transformed into valuable products. Eggshell waste can serve as a solid base catalyst in
biodiesel production, leading to reduced pollutants, lower production costs, and
environmentally friendly processes. Eggshells contain bioactive chemicals, primarily calcium
carbonate (CaCOs3), magnesium carbonate (MgCOg), and calcium phosphate (Caz(POs)2).
They also contain trace amounts of other elements like sodium (Na*), potassium (K"), zinc
(Zn?*), manganese (Mn?"), iron (Fe?*/Fe*"), and copper (Cu®"). Furthermore, eggshells can be
used as absorbents for heavy metals in wastewater treatment and as biomaterials for bone
tissue replacement (Faridi and Arabhosseini, 2018). Rice husk, another abundant waste
product, has significant potential as a biomass source for various applications. It contains
chemical compositions such as silicon oxide (SiO,), aluminum oxide (Al,O3), ferric oxide
(Fe203), calcium oxide (CaO), magnesium oxide (MgO), sodium oxide (Na,O), potassium
oxide (K,0), manganese oxide (MnO,), and sulfur trioxide (SO3). Extracting silica from rice
husk and producing value-added silicon-based compounds is one of the potential uses.
Currently, a substantial amount of rice husk is burned for energy generation, leading to the
production of rice husk ash. However, only a small portion of rice husk is utilized for silica
extraction. Transforming rice husk into a heterogeneous catalyst for biofuel production has
gained attention in research. Catalysts play a vital role in various reactions, making research
on their application essential. In the context of biodiesel production, base catalysts have
shown superior performance compared to acid catalysts, particularly in alkaline catalysis.
Heterogeneous catalysis, which involves solid surfaces facilitating chemical interactions

between molecules, offers advantages over homogeneous catalysis in terms of regeneration,



activity, selectivity, and ease of separation from reactants. Metal oxide catalysts like CaO,
Si0O,, and MgO are commonly employed in reactions (Mohadi et al., 2016).The use of solid-
based catalysts, particularly in renewable energy industries, has gained attention as a means to
reduce reliance on fossil fuels and meet increasing energy demands. Heterogeneous catalysts
offer advantages such as easy separation, catalyst recycling, reduced energy requirements,
and lower water consumption, contributing to a reduction in biodiesel production costs and
addressing corrosion and toxicity challenges (Faruque et al., 2020; Mat.R et al., 2012). The
need for environmentally friendly and renewable energy sources is driven by rising petroleum
prices, population growth, and environmental concerns. Biodiesel, derived from mono-alkyl
esters of long-chain fatty acids found in vegetable oils or animal fats, offers a viable solution.
It aligns with renewable energy objectives and can be used as a drop-in biofuel in existing

diesel engines and infrastructure (Chakraborty et al., 2010; Gerhard, 2010).

2.0 MATERIALS AND METHODS

2.1 MATERIALS/REAGENTS
Tables 1 and 2 show the materials/reagents and equipment used in the experiment

respectively.

Table 1. List of materials/reagent used for the experiment and their sources.

Materials/Reagents Source Remarks

Rice Husk Bosso Rice Milling Factory Brown

Chicken Eggshell Merchant Shop Bosso Light brown



Distilled water SIM Best Chemical Shop. Colourless,

odourless

and tasteless

Hydrochloric Acid (HCI) SIM BEST Scientific and Chemical Colourless
2.2 EQUIPMENT

Table 2. The list of equipment used for the experiment

Equipment Manufacturer Sources

Digital weighing balance

Muffle Furnace

Grinder

Sieve(500mm)

Mortar and Pestle

XRD Machine

FT-IR Machine

Drying Oven

Ceramiccrucible

Hot plate.

Heating Pot

Ohaus cooperation

E. Track England

Pyrex England

Pyrex England

Nigeria Made

Rigaku Tokyo, Japan

Nicolet iS10

Pyrex England

Nigeria Made

Nigeria made

Nigeria made

Chem.Engr.Lab. FUTMinna

SIM Best Chemical Lab.

SIM Best Chemical

SIM Best Chemical Lab,

Bosso Milling Factory

University of Ibadan Lab.

University of Ibadan Lab.

SIM Best Chemical Lab

Step-B lab FUTMINNA

SIM Best Lab Chemical Lab

SIM Best Lab Chemical Lab



2.3 Experimental Method
This shall involve Pretreatment of Samples, Size Reduction, Rice Husk Ash (RHA)
formation, Calcination of the Egg Shell and Rice Husk (RH) and Characterization of the

calcined Materials.

Rice Husk

Pretreatment - — _
rocess Ash Size , | Calcination Characteriz
P Formation Reductio — ation

|

Fig 1: Flowchart of the Synthesis of Eggshell Rice Husk Ash Catalyst

2.21 PRETREATMENT AND CALCINATION OF SAMPLES

2.3.1.1 Rice Husk

Rice Husk was obtained from a rice milling factory and underwent a cleaning process using
distilled water to eliminate soil particles and impurities. It was then naturally dried in sunlight
and stored in an airtight container. Subsequently, 450g of the cleaned rice husk (RH) was
roasted in a heating pot on a heat plate. The resulting roasted rice husk was then quenched in
room temperature distilled water and separated from the water through filtration.The roasted
and quenched rice husk was subjected to leaching. This involved immersing 300g of the
roasted and quenched rice husk in 900ml of diluted hydrochloric acid (HCI) for a duration of
3 hours. The mixture was filtered using filter paper and washed three times with distilled
water. Finally, the residue was dried at 100 °C for several hours in a controlled air
environment and labeled as LRQRH (Leached-Quenched-Roasted Rice Husk).The LRQRH
sample was divided into three equal parts, each weighing 80g and labeled as KD, KE, and
KF. These divided LRQRH samples were then subjected to calcination in a muffle furnace.

The samples were heated to temperatures of 600 °C, 700 °C, and 800 °C, respectively. Once



the desired temperatures were reached, the samples were left inside the furnace to complete

the calcination process. Afterward, they were cooled down and stored for characterization.

fig2: roasted rice husk

3.3.1.2 Egg Shell

The sample was obtained from a merchant located in Bosso Minna, Niger State, Nigeria. It
was washed thoroughly to eliminate any impurities and subsequently dried using sunlight.
The dried sample was ground into a powder using an electric grinder and sieved to remove
some of the white membrane present. The ground samples were then divided into three equal
portions, each weighing 250g. These portions were labeled as KA, KB, and KC, respectively.
They were loaded into ceramic crucibles and subjected to calcination in a furnace at
temperatures of 600 °C, 650 °C, and 700 °C, respectively. Each crucible was left inside the
furnace for a duration of 3 hours after reaching the desired temperature. Following the
calcination process, the samples were cooled down, and subsequently stored for further

characterization



figd: muffle furnace fig5: calcined egg shells

2.4  Characterization of the calcined Egg Shell and Rice Husk

The elemental and physical properties of the prepared samples were assessed through analysis
methods including Fourier Transform-Infrared Ray (FT-IR) and X-ray Diffraction (XRD)

analysis.

2.4.1 X-ray diffraction Analysis for Mineral Identification

The powdered samples were formed into pellets and sieved to a size of 0.074mm. These
pellets were then placed onto an aluminum alloy grid measuring 35mm x 50mm, which was
positioned on a flat glass plate. A paper cover was placed over the samples. While wearing

protective hand gloves, gentle pressure was applied by hand to compact the samples.Each



sample was subjected to analysis using the Rigaku D/Max-IlIC X-ray diffractometer,
developed by Rigaku Int. Corp. in Tokyo, Japan. The instrument was configd to generate
diffractions at a scanning rate of 2 0/min within the 2 to 500 range, at room temperature,
using CuKa radiation set at 40kV and 20mA. The obtained diffraction data, including d
values and relative intensity, were compared to the standard data of minerals from the mineral
powder diffraction file, ICDD. This database encompasses standard data for over 3000
minerals. Similar diffraction data indicates the presence of the same minerals as those found

in the calcined samples when compared to the standard minerals.

fig 6: Rigaku D/Max-IlIC X-ray diffractometer

2.4.2 Fourier Transform -Infrared Ray Analysis for Mineral Identification

It was necessary to sign on the notebook, followed by turning on the computer and signing in.
The next step involves turning on the power of the instrument and waiting for the
initialization process to be successful. If the small panel of the instrument labeled "Perkin
Elmer Spectrum 100 Series” shows a successful initialization, the procedure can continue.
Otherwise, it is advised to seek assistance from Jianhua.To ensure cleanliness, the sample
holder was cleaned using acetone and Kim wipes, taking care not to splash the acetone onto
the instrument. Following this, the "spectrum™ software was launched from the desktop, using

the User Name "Analyst" and Password "analyst". The "Spectrum 100" option should be



selected. Upon accessing the "Instrument setup” button, a dialog box titled "Scan and
Instrument Setup” will appear. It was necessary to input the sample name, scan range (limited
to 650-4500 cm-1), and the desired scan number. To collect background information of the
sample holder, the "background" button should be clicked. The next step involved placing the
sample on the sample holder. If the sample is liquid, pressing "Apply" and then "Start" will
initiate the spectrum collection. In the case of a solid sample, it was advised to first click the
"monitor"” button on the "Scan and Instrument Setup” dialog. Subsequently, the pressure arm
was lowered, and the total pressure applied to the sample was monitored through the
"monitor” dialog. Setting the "Force Gauge" to approximately 80, the process can be
completed by clicking "Finish". Finally, pressing "Apply" and "Start" will initiate the
spectrum collection. For data processing, selecting "View" from the menu and then choosing
"Label Peaks" will enable peak labeling. To label a specific peak, selecting "View" >
"Cursor" > "Vertical Continuous™ activated the cursor, which can be moved to the desired
peak. By selecting "View" > "Label Cursor”, the peak can be labeled. Saving data in ASCII
format can be done by selecting "File" > "Save as" and choosing "ASCII (*.ASC)" as the file
type. After completing the necessary tasks, it was important to turn off the software, log off
the computer, and switch off the instrument. Additionally, the sample holder was thoroughly

cleaned before leaving the FTIR area.

fig 7: FTIR Scientific EQuipment



3.0 RESULT AND DISCUSSION

3.1  Change in physical properties of the materials used (colour change)

Table 3. Change in physical properties of the materials used (colour change)
Material Used Color Change after calcination

Calcined waste eggshell (whitish-brown)

1. 600 °C black
2. 650 °C black-gray
3. 700 °C gray

Calcined Rice husk (brown)

1. 600 °C light-ash
2. 700 °C black-ash
3. 800 °C Ash

The eggshells underwent decomposition through calcination in a furnace at various
temperatures (600 °C, 650 °C, and 700 °C), resulting in a color change. Table 3 illustrates the
observed color changes at different calcination temperatures. At 600 °C, the eggshells
transformed into black powder, while a small amount of black-colored ash was produced at
650 °C. Finally, at 700 °C, a significant amount of black powder with a higher ash content
was obtained. The results indicate that as the calcination temperature increases, there is a
corresponding increase in the formation of metal oxide, as evidenced by the color change in
the chicken eggshell powder (Mohadi et al., 2016). Also the calcined rice husks underwent
decomposition during the calcination process in a furnace at varying temperatures (600 °C,
700 °C, and 800 °C). The samples exhibited an increasing change in color as the calcination
temperature rose, as depicted in table 3. At 600 °C, the rice husks resulted in a light ash
powder, while a black-ash colored powder was obtained at 700 °C. Finally, at 800 °C, an ash-
colored powder was obtained. The results indicate that as the calcination temperature
increases, there is an increased formation of metal oxide, as evidenced by the color change in

the rice husk powder (Sekifuji et al., 2021).



3.2 Loss in mass of the raw materials used

Table 4. Loss in mass of the raw materials used

S/IN  Material Used Calcination temp °C Mass loss after calcination

1.

2.

Initial mass(g) Final mass(g) Mass loss(g) % loss
Eggshell 1) 600 °C 250 188.25 61.75 24.7%
2) 650 °C 250 171.75 78.25 31.3%
3) 700 °C 250 160.75 89.25 35.7%
Rice husk
1) 600 °C 80 19.84 60.16 75.2%
2) 700°C 80 12.32 67.68 84.6%
3) 800 °C 80 8.56 71.44 89.3%

Table 4. shows that there was loss in masses of calcined eggshells rice husks during each
calcination due to thermal decomposition of CaCO3 to CaO and Ca(OH),, which is as a result
of loss in CO, and other impurities, and loss of some volatile materials in Rice husk
increasesas calcination temperature increases and decomposition of Ca,SiO4 to SiO,When
calcined Rice husk at different calcination temperatures from 600 °C to 700 °C to 800 °C.As
showed in table 4. 24.7% was loss when Eggshell was calcined at 600 °C, at 650 °C there was
31.3% loss in mass of Eggshell and highest loss in mass of eggshell at 700 °C of about
35.7%.RH loss it’s mass up to 75.2% by weight at 600 °C, and loss it’s mass up to 84.6% at
700 °C while at 800 °C there was mass loss up to 89.3% as shown in Table 4. due to presence
of physically absorbed moisture and water content in the RH, the removal of organic group
by oxidation reaction and the decomposition of hemicellulose and cellulose followed by total

decomposition of lignin.

3.3  Characterization of the Calcined Eggshells and Rice husks

The samples produced were characterized to know the chemical transformation, crystallinity

and functional groups presence X-ray diffractometer and FT-IR Spectrometer respectively.



3.3.1 X-ray diffraction

Samples were analyzed using Cu- K source equipped with an Inel CPS 120 hemispherical
detector (RigakuD/Max-111C Co., Japan). at scanning rate of 2 %min in the 10° to 55°

3.3.1.1 calcined eggshell

X-ray diffraction is a non-destructive analytical technique which reveals information about

crystallographic structure. This technique is widely used in the characterization of shell. The
XRD patterns for calcined eggshells.

3.3.1.1.1 KA (eggshell calcined at 600 °C)
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fig 8. Eggshell Calcined at 600 °C (KA)

Fig8 showed the highest peak is at 20= 30° shows presence of CaO as crystalline form,there
are more CaO at 20 = 31°, 40° 44° and 47° at difference phases. There is presence of
Ca(OH), at 20= 28°, 42° and 50° as a result of moisture content of the calcined sample.
Cay(Fe)SiO4 exists at 20= 25° shows incomplete decomposition of the eggshell while

hydroxyapatite occurs at 20= 37.5° (Pornchai et al., 2016).



3.3.1.1.2 KB (eggshell calcined at 650°C)
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Fig9 Eggshell Calcined at 650 °C (KB)
Fig9 showed the highest peak is at 26= 22° shows presence of CaO being most abundance in
a crystalline form, there are more formation of as compared to KA, other formation of CaO at
206=15° 22°, 34°, 37° and 42° at difference phases.
There is presence of Ca(OH); at 26= 17°, 44° and 39° where the amount is small as in KA.
Cay(Fe)SiO4 has decomposed to Ca,SiOy4 at 26= 22°, 24°, 27° and 42°.

there is small amount of hydroxylapatite at 26=30° (Pornchai et al., 2016).



3.3.1.1.2 KC (Eggshell Calcined at 700°C)
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Figl10 Eggshell Calcined at 700 °C (KC)

Fig10 showed the highest peak is at 20= 32° with strong crystalline nature as sharp the band
shows presence of CaO being most abundance, there are more formation of CaO as compared
to KA and KC, other formation of CaO at 26= 26°, 32° in small quantity and at 20= 44°, 47°
and 42° at amorphous-like indicated that the sample is getting from crystalline to amorphous.
There is presence of Ca(OH), at 26= 28°, 34°, 40° and 50° in small amount as a result of
decreased in moisture content as temperature increased where.. Ca,(Fe)SiO4 has decomposed

to Ca,SiOy4 at 20= 33° and 52° there is smaller amount of hydroxylapatite at 26=38° (Mohadi

et al., 2016).



3.3.1.2 calcined rice husk

X-ray diffraction is a method of analysis that provides insights into the crystal structure
without causing damage. It is extensively employed in the examination of shells to
understand their crystallographic arrangement. The XRD patterns for processed rice husks
can be obtained using this technique.

3.3.1.2.1 KD (rice husk calcined at 600 °C)
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Figll. Rice Husk Calcined at 600 °C (KD)

The highest peak is at 26= 21° being the abundance component shows presence of Ca,SiOy it
exists at 20=22°, 28° and 37° and SiO4is at 20=15°, 34°, 36°, 37° in small amount.

Ca(OH), occurred in small amount and there is a trace of hydroxylapatite at 42° also trace of

MgO and Fe,0s.



4.3.1.2.2 KE (rice husk calcined at 700 °C)
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Figl2. Rice Husk Calcined at 700 °C (KE)

The highest peak is at 20= 22° and 31° being the abundance component shows presence of

SiOy4 in crystalline state. At 20=22°, 38° and 37° there is Ca,SiO, formation there is absence

of hydroxylapatite , also trace of MgO and Fe,Os.



4.3.1.2.3 KF (rice husk calcined at 800°C)
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Fig 13. Rice Husk Calcined at 800 °C (KF)

The highest peak is at 20= 18°, 22° and 28° showed SiO, present in highest composition,
Ca,Si04 exists at 20= 21° in small amount due to more decomposition of the sample at this
temperature.Ca(OH), occurred in small amount and there is a trace of hydroxylapatite at 24°
also trace of MgO, CaO and Fe,O3 were observed.

Table 5. Crystallite size (nm) using Scherrer equation

Sample Average Crystallite size (nm)
KA 177.3967207
KB 274.7932751
KC 278.0374549
KD 274.7932751
KE 238.7086417

KF 16.72281279




An examination of crystallite size changes with increasing temperature using the Scherrer
equation reveals that the size of the crystallites in calcined Egg Shell increases between 600
°C and 700 °C. Among the samples, KC exhibits the largest crystallite size. On the other
hand, the crystallite size of calcined Rice Husk decreases as the calcination temperature rises.
Among them, KD, calcined at 600 °C, has the highest crystallite size, while KF exhibits the
smallest crystallite size among all the samples.

3.3.2FT-IRRESULTS

The samples were characterized to know functional groups present using Perkin Elmer

Spectrum 100 Series, Nicolet iS10 FT-IR Spectrometer.

3.3.2.1 Eggshell
Eggshell was characterized by FTIR. This technique could be used to identify the major
functional groups consisting Calcined eggshell. From the wave number of the molecular

vibration modes, a good explanation of the chemical structure could be obtained



3.3.2.1.1 KA (eggshell calcined at 600 °C)
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Figl4. Eggshell Calcined at 600 °C (KA)

The highest band is at 707.82 cm™ indicates presence of symmetric stretching vibrations of
CO5 bond due to presence of CaCOs, -OH group presents at 3761.41cm™, 3691.66 cm™ and
3442.00 cm™ due to presence of hydroxyapatite, Ca—OH, —OH-Si, and Ca—OH-Si units in

the octahedral layer.There was a broad band at 1460 cm™ due to bending vibrations of the Si-
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3.3.2.1.2 KB (eggshell calcined at 650 °C)
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Figl5. Eggshell Calcined at 650 °C (KB)

The highest band is at 707.79 cm™ indicates presence of symmetric stretching vibrations of
CO5 bond due to presence of CaCOs, -OH group presents at 3441.00 cm™ due to presence of
Ca(OH), and small hydroxylapatite as compared to KA.There was a broad band at 1427 cm™
due to bending vibrations of the Si-O-Si group and sharp band at 872.86 cm™ due to presence

of Ca-O bhond.



3.3.2.1.3 KC (eggshell calcined at 700 °C)
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Fig16. Eggshell Calcined at 700 °C (KC)

The characteristic IR band of eggshell appeared at 3775.00 cm™ and 3458.21 cm™ represent
the fundamental stretching vibrations of different -OH groups present in Ca—OH, ~OH-Si,
and Ca—OH-Si units in the octahedral layer. The strong peak appears at 876.35 cm™ is related
to the stretching vibrations of Ca—O, while the bands at 525 and 466 cm™ are due to Ca—O-Si
and Ca—O-Ca bending vibrations, respectively. This shows highest formation of CaO

(Pornchai et al., 2016).

3.3.2.2 Rice husk

KD, KE and KF consist of mixture of CaO and silicate mineral. SiO, are present as dominant
mineral in all patterns. Fig.17 shows that the percent of SiO2 increase significantly after
purification process while the percent of CaO in purified eggshell is increased. K-E and K-F

shows similar pattern for the calcined eggshell with SiO2 as the main mineral.



3.3.2.1.4 KD (rice husk calcined at 600 °C)
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Figl7. Rice Husk Calcined at 600 °C (KD)

There is -OH group at 3457.00 cm™ indicated presence of Ca(OH), in small amount. The
highest peak at 370.19 cm™and 600 cm™ are due to presence of bending vibration of Si-O-Si
bond and band 1387.00 cm™ is as a result of bending vibration of the CHs group in cellulose
as a residue and 1712.70 cm™ can be as a result of C=O bond in carbonyl group

Hemicellulose.



3.3.2.1.5 KE (rice husk calcined at 700 °C)
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Figl18. Rice Husk Calcined at 700 °C (KE)

The spectrum is a complex one with more than 5 bands, the 4027.00 cm™ and 3428.00 cm™
are as a result of -OH group in Ca-OH and Ca—OH-Si. bands at 600.36 cm™ and 448.00 cm™
are due to bending vibration of Si-O-Si bondC-H bond in lignin could be at the 901.00 cm™ as
shown in small amount, at 1048.42 and 1102.36 could be accounted for presence of Si-O-Si

bondin another phase.



3.3.2.1.6 KF (Eggshell Calcined at 800 °C)
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Figl19. Rice Husk Calcined at 800 °C (KF)
The -OH group vibration is shown at 3694.44 cm™ and 3456.21 cm™ and the band at 424.17
cm™, 462.58 cm™ and 541.11 cm™ are all due to stretching vibration of Si-O-Si bond.Lignin

compound having C-H bending vibration formed at 688.29 cm™
40 CONCLUSION

The study successfully investigated the effects of calcination on the physiochemical
properties of solid wastes, namely Eggshell and Rice husk, used as heterogeneous catalysts.
The results showed significant changes in properties such as color, weight, crystallinity,
chemical transformation, and functional groups with increasing calcination temperature. XRD
analysis revealed the presence of potassium compounds in roasted rice husk due to leaching
effects. The highest amounts of Ca0 and silicon (IV) oxide were observed at the highest

calcination temperatures for eggshell and rice husk, respectively. Crystallite size increased for



calcined Egg Shell between 600 °C and 700 °C, with KC having the largest size, while the
size decreased for calcined Rice Husk with increasing temperature. FT-IR analysis indicated
the presence of CO3? in certain samples, suggesting higher decomposition and impurities.
Based on the findings, KC (calcined at 700 °C) was identified as the best catalyst for eggshell,

and KD (calcined at 600 °C) for rice husk, due to high crystallinity and low impurities.
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